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LICENSE AGREEMENT
For

“BACnet® Gateway for VRF System”

IMPORTANT-READ CAREFULLY
This “BACnet® GATEWAY for VRF SYSTEM” License Agreement (“LICENSE AGREEMENT”) is a legal agreement between 
you and Fujitsu General Limited (“FGL”) for the use of VRF BACnet® GATEWAY products consisting of computer software and 
online, electronic and/or printed documentation (collectively “SOFTWARE PRODUCT” or “SOFTWARE”). By installing, copy-
ing, or otherwise using the SOFTWARE PRODUCT, you accept to be bound by all of the terms and conditions of this LICENSE 
AGREEMENT. If you do not agree to any of the terms and conditions of this LICENSE AGREEMENT, you shall not use the 
SOFTWARE PRODUCT and shall promptly return the SOFTWARE PRODUCT to the place where you have obtained it.

COPYRIGHT AND OWNERSHIP.1. 
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties as well as other intellec-
tual property laws and treaties. The SOFTWARE PRODUCT is licensed to you, not sold. FGL owns the title, copyright, 
and other intellectual property rights in the SOFTWARE PRODUCT.

GRANT OF LICENSE.2. 
FGL hereby grants you the limited, non-exclusive and non-transferable rights to use the SOFTWARE PRODUCT only for 
the purpose of controlling the VRF air-conditioning system products (VRF) provided you comply with all terms and condi-
tions of this LICENSE AGREEMENT. You may copy the SOFTWARE PRODUCT solely for backup or archival purposes.

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.3. 
LIMITATIONS ON REVERSE ENGINEERING, DECOMPILATION, AND DISASSEMBLY.(1) 
You shall not modify, alter, reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT. You shall not 
alter or remove any copyright, trademark or other proprietary notice of FGL from the SOFTWARE PRODUCT.

NO RENTAL, LEASE AND TRANSFER.(2) 
You shall not rent, lease or transfer the SOFTWARE PRODUCT to any person and/or entity (-ies).

TERMINATION.(3) 
Without prejudice to any other rights, FGL may terminate this LICENSE AGREEMENT if you fail to comply with any 
terms and conditions of this LICENSE AGREEMENT. In such an event, you shall promptly return all originals and 
copies of the SOFTWARE PRODUCT to FGL.

INSTALLATION AND USE OF SOFTWARE PRODUCT.4. 
You may install and use the enclosed SOFTWARE PRODUCT on a single computer under one of the operating environ-
ment identified in the documentation accompanying the SOFTWARE. You shall not network the SOFTWARE or otherwise 
use it on more than 1 computer at the same time. The infrastructure necessary to use the SOFTWARE PRODUCT (PC, 
accessories, etc.) shall be prepared separately by you. 

NO WARRANTY.5. 
FGL EXPRESSLY DISCLAIMS ANY WARRANTY FOR THE SOFTWARE PRODUCT. THE SOFTWARE PRODUCT IS 
PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITH-
OUT LIMITATION, STATUTORY WARRANTIES, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR 
NON-INFRINGEMENT OF THIRD PARTY’S RIGHTS. THE ENTIRE RISKS ARISING OUT OF USE OR PERFORMANCE 
OF THE SOFTWARE PRODUCT REMAIN WITH YOU. HOWEVER, IF YOU NOTIFY FGL OF PHYSICAL DEFECT OF 
THE MEDIA CONTAINING SOFTWARE WITHIN (90) DAYS FOLLOWING YOUR RECEIPT OF THE SOFTWARE PROD-
UCT, FGL WILL REPLACE THE DEFECTIVE MEDIA WITH NEW MEDIA.
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LIMITATION OF LIABILITY.6. 
IN NO EVENT SHALL FGL BE LIABLE TO YOU OR TO ANY THIRD PARTY FOR ANY DIRECT OR INDIRECT DAMAG-
ES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFIT, BUSINESS 
INTERRUPTION OR LOSS OF BUSINESS INFORMATION, DAMAGES ARISING OUT OF DATA OR INFORMATION 
DERIVED FROM OR BASED ON THE ELECTRICITY CHARGE APPORTIONMENT FUNCTION IN THE SOFTWARE 
OR ANY OTHER PECUNIARY LOSS), ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE , EVEN IF 
FGL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

ENTIRE AGREEMENT.7. 
This LICENSE AGREEMENT (including any addendum or amendment to this LICENSE AGREEMENT included with 
the SOFTWARE PRODUCT) is the entire agreement between you and FGL relating to the SOFTWARE PRODUCT and 
supersedes all prior contemporaneous oral or written communications, proposals and representations with respect to the 
SOFTWARE PRODUCT or any other subject covered by this LICENSE AGREEMENT.

INDEMNITY.8. 
You agree to indemnify and hold FGL, and its subsidiaries, affiliates, officers, agents, co-branders or other partners, and 
employees, harmless from any damage, claim or demand, including without limitation reasonable attorneys’ fees, made 
by any third party due to or arising out of use of the SOFTWARE PRODUCT.

GOVERNING LAW AND JURISDICTION.9. 
This LICENSE AGREEMENT is governed by the laws of JAPAN. You and FGL hereby irrevocably consent to the exclu-
sive jurisdiction and venue in the Tokyo District Court and other higher courts having jurisdiction in Japan for the settle-
ment of disputes arising under or in connection with this LICENSE AGREEMENT.
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Usage Precautions1. 
Precautions When Using the BACnet1-1 ® Gateway

Please read and agree to the LICENSE AGREEMENT FOR “BACnet1. ® Gateway” at the beginning 
of this manual before using the BACnet® Gateway. 

Please confirm that the PC for the BACnet2. ® Gateway meets the operating condition of the “Product 
Specifications” described in the Appendix of this manual.

Please read and fully understand this manual before using the BACnet3. ® Gateway. 

Be careful not to shutdown or turn off the power supply of the PC or unplug its transmission adap-4. 
tor. Do not terminate the BACnet® Gateway  program unless necessary. Otherwise, normal op-
eration of the BACnet® Gateway may not be performed.

To ensure continuous normal operation of this software,set the PC so that it would not go into an 5. 
energy saving mode such as standby mode, sleep mode or execute hibernation. If the PC goes 
into a standby, sleep mode or execute hibernation, this software may not function properly. The 
method for releasing the energy saving or hibernation of the PC depends on the Windows ver-
sions. For windows® 7, right click the desktop to select "Personalize" and click "Screen Saver" 
icon to select "Change power settings". Check "Power saver" in the "Preferred plans" and select 
"Change plan settings" to set "Never".

The DVD for this software and the software protection key (WIBU-KEY) will not be reissued. 6. 
Keep and handle them with great care after installing.

BACnet7. ® Gateway programs perform schedules, operation recording and electricity apportion-
ment data control based on date and time set in the personal computer. Adjust date and time pe-
riodically and by a small amount. Changing date and time may affect the functions listed above. 
When the date/time of the PC running BACnet® Gateway is adjusted to roll back in time, the data 
collected for the electricity charge apportionment for that period will be deleted and be newly col-
lected. When the date/time is adjusted to roll forward in time, there will be no data for that period. 
Such cases will result in incorrect calculation results for the electricity charge apportionment so 
the user should be careful when adjusting date/time for the PC.

When program execution environment of Windows8. ® is corrupted or abnormal, or if other software 
is installed or running on the same PC, operation of BACnet® Gateway may be interfered and 
may not install or run properly. It is usually extremely difficult to detect such conditions, if it oc-
curs. It is recommended that BACnet® Gateway be installed on a new PC, dedicated for the use 
of BACnet® Gateway. 

BACnet9. ® Gateway product is provided with software, drivers, components listed below. If the 
same kind of software, drivers, components with different version is installed on the same PC, 
BACnet® Gateway may not install or run properly.

Microsoft(1) ® SQL Server® Express
OpenLDV (U10 USB Network Interface driver)(2) 
WIBU-KEY driver(3) 

This product may be updated without prior notice. If by chance you encounter any trouble with 10. 
this product , check with your dealer for updates.
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How To Use This Manual2. 
Manual Composition2-1 

This manual is composed of 5 sections.
Introduction ●
Installation ●
Settings ●
Operation ●
Appendix ●

Before installing the software, read the Introduction first and check the Overview of the BACnet® Gateway 
and the notes and cautions.

When installing the BACnet® Gateway to the PC, read the Installation and Settings sections. Complete 
installation to the PC in accordance with the procedure described.

When performing operations related to various functions of the BACnet® Gateway after installation, refer to 
the relevant parts of the operation section.

The Appendix is made up of product specifications, error code table, and FAQ. Read them as required.

Interface Specification document is also available and should be referred to along with this manual.
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3-1 Features

=

VRF System 0

BACnet® Operator
Workstation (B-OWS)

VRF System 1

.

.

.

.
(Max. 4 VRF Systems)

Echelon®U10 
USB network 
interface (field 
supply)

PC Hardware
(field supply)

BACnet®/IP

BACnet® Gateway
(UTY-ABGX)

DVD-ROM
(Software)

WIBU key
(Software 

protection key)

USB port
LAN port

Lighting
facilities

Security
system

Automatic fire
alarm interface

Ventilation
system

BACnet® Gateway for
each system

VRF network USB Ethernet

Echelon®U10 
USB network 
interface (field 
supply)

Echelon®U10 
USB network 
interface (field 
supply)

Echelon®U10 
USB network 
interface (field 
supply)

BACnet® Specification of UTY-ABGX
•ANSI / ASHRAE Standards 135-2004
•BACnet® Application Specific Controller (B-ASC)
•BACnet® / IP over Ethernet BACnet®

Gateway
VRF system Operator

Workstation
The maximum number of connecting systems

VRF System 4 systems

For the numbers of the Units that can connect with 1 
VRF System, Indoor and Outdoor Units are up to 400 
units and up to 100 units respectively.

VRF System Address: * 
The numbers from 0 to 3, which are assigned to each VRF System in the BACnet® Gateway. 
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Materials necessary at installation
WIBU-KEY (packed together with product) ●
U10 USB Network Interface (adaptor with connection to VRF network work finished) ●
Administrator ID and password for Windows login (arbitrarily decided by the user. 2 byte characters can- ●
not be used.)
BACnet ● ® Gateway setup DVD (For details, see the next page.)
IP address ●

When number of USB ports for WIBU-KEY and U10 USB Network Interface are 
insufficient;

USB hub ●

Setup	DVD	configuration	(Reference)

Manual BACnet® Gateway Manual.pdf
(PDF	file	for	this	manual)
+Interface	Specification.pdf

LicenseAgreement LicenseAgreement.pdf

ReadMeFirst.txt
Read before installing the software application.

ISSetupPrerequisites

Tools OpenLDV

Driver for U10 USB Network Interface
When the Driver for U10 USB Network Interface is installed, execute it.

WibuKey

Driver for WIBU-KEY
This software is necessary to use WIBU-KEY
It is usually installed automatically when BACnet® Gateway is installed to 
the PC.
When the driver for WIBU-KEY is installed manually, execute it.

setup.exe
Install the BACnet® Gateway to the PC.
Execute the setup.exe to install.
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Installation5. 
This section describes the procedure when installing the BACnet® Gateway software to the PC which con-
nects directly to the VRF network. The PC communicates directly with the indoor and outdoor units. 

The PC and VRF network are connected by a Transmission Adaptor (U10 USB Network Interface).

This section also describes how to uninstall the software when BACnet® Gateway software becomes un-
necessary and also, how to reinstall the installed software due to software upgrading or other reasons.
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Installation Flow5-1 

Installation/Setting Flow

5-2 Hardware Installation

5-3 Software Installation

Microsoft® .NET Framework 4
Microsoft® SQL Server® 2008 R2 Express

BACnet® Gateway
WIBU-KEY Setup

6 Basic Setting

 WARNING!
BACnet ® Gateway is tested to install and operate under new Windows environment. When 
program executional environment of Windows is corrupted or abnormal, or other softwares 
that interfere with the operation of BACnet® Gateway is installed or running, BACnet® Gate-
way may not install or run properly. It is usually extremely difficult to detect such conditions, if 
it occurs.

BACnet ® Gateway product is provided with softwares, drivers, components listed below. If the 
same kind of softwares, drivers, components with different version is installed on the same 
PC, BACnet® Gateway may not install or run properly.

Microsoft(1) ® SQL Server® Express
Open LDV (U10 USB Network Interface driver) (2) 
WIBU-KEY-driver(3) 

Do not insert U10 USB network interface adaptor to the USB slot of the PC BEFORE its driver 
is installed. 

Do not turn on the power of indoor/outdoor units until all installation work is completed.
Do not insert WIBU-KEY to the USB port of the PC until instructed.5
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Hardware Installation (Transmission Adaptor)5-2 

55555 Transmission Adaptor Installation

UTY-ABGX
BACnet® Gateway

Transmission Adaptor
(U10 USB Network Interface)

VRF System 3

VRF System 2

VRF System 1

VRF System 0

USB cable

The BACnet® Gateway can connect up to 4 VRF Systems. Since 1 Transmission Adaptor connects to 
1 system, up to 4 Transmission Adaptors are connected.

Following chart shows the detail of the U10 USB Network Interface Adaptor. These adaptors are not includ-
ed in the BACnet® Gateway product and must be procured in advance. 

Name & Shapes Q’ty Remark

Transmission Adaptor (U10 USB Network Interface 
-TP/FT-10 Channel)

(Field Supply)

Procure the necessary number 
in accordance with the number 
of connection systems.

Model : 75010R
(Echelon® Corporation)

It is necessity that set Transmission adaptor respectively because of the S/V series and V-II/J-II/VR-II series 
can not be connected to the same communication line.
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Installing U10 USB Network Interface Adaptor
To use this product, turn on the power of the PC and install necessary drivers/software for this product (BE-
FORE connecting it to any USB port ), following the ***QUICK START*** enclosed with this product.

When using multiple U10 USB Network Interface adaptors, confirm in advance, which U10 USB Net-
work Interface adaptor connects to which VRF Network (Attach labels to the U10 USB Network Inter-
face adaptors If possible). These information will become necessary during the setup procedure of 
BACnet® Gateway (You will be required to specify which U10 USB Network Interface adaptor corre-
sponds to which VRF network). 

1

2

3
4

VRF0

LON1

LON2

LON3

LON4

VRF1
VRF2

VRF3

Keeping a record of a table such as shown below is recommended.

LON No. Adaptor No. VRF System No.

LON1 Adaptor 1 VRF 0

LON2 Adaptor 2 VRF 1

LON3 Adaptor 3 VRF 2

LON4 Adaptor 4 VRF 3

Note. “LONx” is used to identify U10 USB Network Interface adaptor. LON numbers are given in the or-
der they are inserted to a PC for the first time and basically, never changes, even if you change USB slot 
afterwards. 

Connect the U10 USB Network Interface adaptor to the personal computer USB port.
When there are multiple U10 USB Network Interface adaptors, connect each U10 USB Network Inter-
face adaptor in the order of its LON number. 
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Wiring and Turning on the Units Power55555 

Once the wiring has been installed, the power can be turned on. Follow the procedure below for turning on 
the power.

Connect VRF network cables to the corresponding U10 USB Network Interface adaptors. 
Turn on the power for all connected indoor units.
Turn on the power for all connected outdoor units.

Make sure that USB equipment (USB hub, etc.) that this product is connected to, is not overloaded (power sup-
plied thru the interface does not exceeds the maximum limit).

Note

Turn on the power for BACnet® Gateway PC, if it is not yet turned on.
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Software Installation5-3 
The following software is installed here.

Microsoft® .NET Framework 4 ●
Microsoft® SQL Server® 2008 R2 Express ●
BACnet® Gateway ●
WIBU-KEY driver ●

Before starting the installation of this product, check each of the followings. 
Install Adobe® Reader® (Ver. 9.0 or later) prior to the installation. (Adobe® Reader® does not come  ●
with this product).
Have the installation DVD of the Windows version (Windows® XP, Windows Vista® or Windows® 7)  ●
used for the PC ready. 

Remove all program as described in “5-4 Software Uninstallation” , if you have the same or previous  ●
version of BACnet® Gateway.
Do NOT insert WIBU-KEY (Software protection key) enclosed with this product to the PC until product  ●
installation is completed.
You are required to login to the computer as Administrator (or equivalent) to the PC to install this prod- ●
uct. (Enter the ID with single-byte characters.)
Stop all running programs before you start the installation. ●
If Anti-Virus software product is installed, temporarily disable the software during the installation of this  ●
product.

Execute setup.exe in the root folder on the BACnet® Gateway setup DVD.
Microsoft ● ® .NET Framework 4

.NET Framework 4 is installed automatically if it is not already installed.
Microsoft ● ® SQL Server® 2008 R2 Express

Microsoft® SQL Server® 2008 R2 Express is installed automatically if it is not already installed.
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Select the language.
Select the desired language.

Click the “OK”button.





Click the “Install” button.


When “Install” is selected, installation begins. 5
a When “ReadMeFirst.txt” is selected, ReadMe is displayed.

Be sure to read it for important information.
Note

b When “Manual” is selected, the manual is displayed.

5

(b)
(a)
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BACnet® Gateway ●

Install BACnet® Gateway. Click the “Next” button.


If the BACnet® Gateway end user “License Agreement” is displayed, confirm the contents.
If you can agree to the terms of the “License Agreement”, check “I accept the terms in the license 
agreement” and click the “Next” button.




Specify the installation “Destination Folder” and click the “Next” button.
(To change the installation “Destination Folder”, click the “Change” button and select the folder to be 
installed.)
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If the installation setting contents are correct, click the “Install” button.


Installation starts.
The necessary drivers are also installed at the same time. 

WIBU-KEY driver ●

A description of WIBU-KEY Setup is displayed. Confirm the contents.
Click the “Next” button.


Select the language.
Check the desired language.

Click the “Next” button.
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When the screen to specify the installation “Destination Folder” is displayed, specify the installation 
“Destination Folder” and click the “Next” button.


Click the “Yes” button.



The WIBU-KEY components selection screen is displayed.
Uncheck all the checkboxes and click the “Next” button.
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If the WIBU-KEY driver installation contents are displayed, confirm the contents and click the “Next” 
button. 


Installation starts.
When “Next” button is enabled, click the “Next” button.


WIBU-KEY Setup is complete.
Uncheck the checkbox and click the “Finish” button.
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WIBU-KEY Setup was successful.
Click the “OK” button.



A message appears saying whether or not you want to start the BACnet ® Gateway automatically.

 

When the "Yes" button is clicked, the BACnet® Gateway is registered at the following location and au-
tomatically starts when the PC is booted.

For VISTA/7: The BACnet® Gateway is registered at the task scheduler.
 When deleting, start the task scheduler and delete.
 Control Panel - Administrative Tools - Task Scheduler

For XP: Shortcut is created at Startup.
 When deleting, delete the shortcut files of the following folders:
 C:\Documents and Settings\Administrator\Start Menu\Programs\Startup

 

VISTA/7 XP
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If this screen is displayed, installation of the BACnet® Gateway for VRF System to the PC is complete.
Click the “Finish” button


After the end of installation, reboot the PC.
Click the “Yes” button.



After reboot the PC, connect the WIBU-KEY and the U10 USB Network Interface adaptor to USB port 
of the PC.
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Software Uninstallation5-4 
When uninstalling the software from PC, follow the procedures shown below.

5-4-1  BACnet® Gateway Uninstallation

5-4-2 WIBU-KEY Driver Uninstallation

5-4-3 Microsoft® SQL Server® 2008 R2 Uninstallation and Native Client  Uninstallation

When you intend to reinstall BACnet® Gateway later, export “All Data” at this point.
→8-3-3   “All Data Export”
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BACnet® Gateway Uninstallation55555 

When you need to keep the data for later use, export the data before uninstalling the BACnet ● ® Gate-
way.

Write all the data by exporting.      → 8-3  “Data Import/Export”

Note

Select the menu items in order of “start”→“Control Panel”→“Program and Features”.
Select the “BACnet® Gateway for VRF System (UTY-ABGX)”.
Click the “Uninstall” button.




When the “Yes” button is clicked, uninstallation begins.


When the screen displaying the uninstallation process closes, uninstallation is complete.5
Close the “Program and Features” screen by clicking the [×] at the top right-hand corner of the screen.
A folder named the BACnet® Gateway remains in the folder designated the BACnet® Gateway installation folder * 
at installation even though uninstallation is performed.
There is no problem even if this folder remains as is, but it doesn’t matter if the folder is deleted.
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WIBU-KEY Driver Uninstallation55555 

Execute only when you know for certain that the WIBU-KEY driver is not used by programs other than the 
BACnet® Gateway.
If unknown, do not uninstall the WIBU-KEY driver
Remove WIBU-KEY from the PC before uninstalling it.

Select the menu items in order of “start”→“Control Panel”→“Program and Features”.
Select “WIBU-KEY Setup (WIBU-KEY Remove)”.
Click the “Uninstall/Change” button.





Click the “Next” button.
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Check “Ignore, Setup will replace file at system startup (reboot required).”5



5

Click the “OK” button.
When this screen is displayed, uninstallation of the WIBU-KEY driver is  complete.
Click the “Finish” button.


Close the “Program and Features” screen by clicking the [x] at the top right-hand corner of the screen.
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Microsoft® SQL Server® 2008 R2 Uninstallation55555 

Execute only when you know for certain that Microsoft® SQL Server® 2008 R2 is not used by programs 
other than the BACnet® Gateway.
If unknown, do not uninstall the program.

Select the menu items in order of “start”→“All Programs”→“Microsoft SQL Server 2008 R2”→ 
“Configuration Tools”→“SQL Server Configuration Manager”.

Select “SQL Server Services”.
Right-click “SQL Server (SQLEXPRESS)”.
Select “Stop”.
When [×] is clicked, “SQL Server Configuration Manager” is completed.5



5




Select the menu items in order of “start”→“Control Panel”→“Program and Features”.
Select “Microsoft SQL Server 2008 R2”.
Click the “Uninstall/Change” button.
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After this, follow the instructions on the screen.   
For details, refer to the Microsoft website.  

When uninstall is ended, uninstall "Microsoft SQL Server Native Client" in the same manner



6. Basic Settings
7. Electricity Charge Apportionment (ECA) Setting

Settings
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Basic Settings6. 
In this section, the basic settings necessary before use in the PC are explained. The settings that are also 
necessary when equipment configuration changes are also explained here.
When starting the system for the first time after installation, make the settings in accordance with the flow 
described below. At the 2nd and subsequent starting, make the necessary settings in accordance with sub-
sequent paragraphs, as required.

When Starting for the First Time6-1 
When starting the BACnet® Gateway for the first time, perform the settings in accordance with this flow.  

Setting for First Time Use ●

CancelOK

CancelOK

CancelOK

OK

6-5 “Adaptor Setting”

Transmission adaptor selection ●
Transmission Adaptor Name setting ●
Transmission line connection confirmation ●

Main screen BACnet® Gateway program ends.  
(When Cancel is selected, Setting is stopped.
Setting must be repeated from the beginning.)

BACnet® Gateway 
program ends.

(b)

CancelOK(a)

6-2 “Selection of Unit Data Acquisition Method”

To perform “Adaptor Setting”. ............................. (a)
To import backed up data. .................................. (b)

6-3 “Login Setting”

6-4 “Initial Setting”

6-6 “Unit Registration”
Scanning range ●

Device confirmation ●

CancelOK

Items Which Can Be Arbitrarily Set ●

6-7 “Description Property Setting”

6-8 “Change Password” 
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“Selection of Unit Data Acquisition Method”6-2 
This setting is performed only at first start settings.

To perform 6-5 “Adaptor Setting” processing, select (a).
To import backed up data, select (b).

Click the “OK” button.

(a)
(b)


"Login Setting"6-3 
This setting is performed first start settings.

Login ID
Enter the administrator's login ID.
(Within 20 characters of alphabet and numeric)

Password
Enter the administrator's Password.
(Within 20 characters of alphabet, numeric, and symbol)
Password can be changed. See 6-8 Change Password.

Password Confirmation
Enter the administrator's Password again for confirmation

Omit Login screen at startup
When checked, the password input screen is omitted when the application is started from the next time.
At the end of an application, at DB importing, etc. the password input screen is displayed the same as 
up to now.
This setting can be changed by 6-4 Initial Setting screen and 6-8 Change Password screen.


5

Click the “OK” button.5
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“Initial Setting”6-4 
Makes any settings and changes necessary before operation.

When you want to reset Initial Setting, open the “Initial Setting” screen.
Select the menu items in order of “Setting”→“Initial setting” from the Menu bar.



Input or check each item of the screen shown below.
Always set “IP Address” and “Subnet Mask".
Change other items as required.


When “Omit Login screen at startup” is checked, the password screen is omitted at application starting 
from the next time.  
At the end of an application, at DB importing, etc. the password input screen is displayed the same as 
up to now.  

Click the “OK” button.
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Items Contents
“IP Address” Enter the IP address used in BACnet® communications. (IPv4 only)

“Subnet Mask” Enter the subnet mask corresponding to the IP address used in 
BACnet® communications.

“Device Instance No.” Enter the Instance No. of the local Device.

“Device Object Name” Enter the object name of the local Device. (Up to 50 ASCII charac-
ters)

“Max_APDU_Length_Accepted” Select the acceptable APDU length.
“APDU_Timeout (m sec)” Enter the APDU timeout time in milliseconds.
“Number_of_APDU_Retries” Select the number of retries when time out occurs.

“APDU_Segment_Timeout (m sec)” Enter the internal time at which APDU segment is resent, in milli-
seconds.

“I-Am Service Broadcast Sending 
(at 60-second intervals)”

Check when you want to send I-Am Service periodically. (60-second 
intervals)

“Unconfirmed COV Notification Service 
Broadcast Sending”

COV notification is sent by broadcast even when SubscribeCOV 
service is not subscribed. Refer to the interface specifications for 
the target object.
* Depending on the number of units and their status,large number 

of packets are sent.
“Process ID” Process ID used when sending COV notification.
“Synch. VRF System Time to Time Synchro-
nization/UTCT Time Synchronization.”

Check if you want to send “system time setting” to VRF units when 
TimeSynchronization/UTCTimeSynchronization Service is received.

“Register as Foreign Device with BBMD” Check when you register as an external device to BBMD.
“BBMD at IP Address” BBMD IP address.
“BBMD at UDP Socket” BBMD UDP port No.

“Temperature Units” *1 “Celsius” or “Fahrenheit” can be selected. Select the units to be 
used at temperature display.

“Capacity Units” “BTU” or “kW” can be selected. The selected unit will be used for 
displaying the capacity values in the main screen.

“Omit Login screen at startup”

When “Omit Login screen at startup” is checked, the password 
screen is omitted at application starting from the next time.
At the end of an application, at DB importing, etc. the password 
input screen is displayed the same as up to now.

Also, the following property values of the following objects will be converted automatically. 

*1 Property Identifier For CELSIUS For FAHRENHEIT

AI_Object

Present_Value CELSIUS Temperature FAHRENHEIT Temperature
Units DEGREES-CELSIUS DEGREES-FAHRENHEIT
High_Limit Default:30.0 Default:88.0
Low_Limit Default:10.0 Default:48.0

AO_Object

Present_Value CELSIUS Temperature FAHRENHEIT Temperature
Units DEGREES-CELSIUS DEGREES-FAHRENHEIT
Priority_Array CELSIUS Temperature FAHRENHEIT Temperature
Relinquish_Default Default:26.0 Default:80.0
High_Limit Default:30.0 Default:88.0
Low_Limit Default:10.0 Default:48.0

Temperature unit can only be selected from this screen. It is not possible to change the temperature unit 
from BMS.
The temperature unit should not be changed during operation. If changed, the user must notify the BMS 
of the change. 

Notes on the temperature unit setting screen  
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“Adaptor Setting”6-5 
Sets the Device Name and confirms the Device State of the Transmission adaptor (U10 USB Network Inter-
face) that connects the “BACnet® Gateway”.

When you want to reset “Adaptor Setting”, open the “Adaptor Setting” screen.
Select the menu items in order of “Setting”→“Adaptor setting” from the Menu bar.



The Adaptor Name can be set for easy identification by the user. Click the Adaptor Name you want to 
set and enter the text. (Default name: “AdaptorX”) 
Up to 20 characters (alphabet, numeric, and symbol) can be set. The Adaptor Name cannot be dupli-
cated. Only the connected adaptor can be set.

Usable device setting and confirmation are possible.

“D
ev

ic
e”

Name A usable devices list (LONx) or “Not Used” can be pulled down and selected.

“Status”

Displays the device status.
“Ready” The specified adaptor can be used.
“Busy” The specified adaptor is being used by another system.
“Error” The specified adaptor cannot be used.
(Blank) Not displayed when an adaptor is not connected.

“Check”

When the “Wink” button is clicked, the SVC lamp of the speci-
fied device lights (for approx. 2 second) and you can confirm 
which Transmission line the adaptor is connected to. (Only 
when the Device Status is Ready)

SVC Lamp







“OK”:  Saves the settings and ends setting work.
“Cancel”:  Ends setting work without saving the settings. 

Adaptor Name is a name which can be arbitrarily set so that the user can easily identify connection of the 
Transmission adaptor (U10 USB Network Interface). (Default name: “AdaptorX”)
“Device Name” is a name automatically allocated to the network when a “Transmission adaptor” (U10 
USB Network Interface) is connected. (User may select the  LONx number)

Note
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“Unit Registration”6-6 
Scans by the network and detects and registers usable R.C. groups and outdoor units.
The units registered by scanning are managed by BACnet® Gateway.

When you want to reset “Unit Registration”, open the “Unit Registration” screen.
Select the menu items in order of “Setting”→“Unit Registration” from the Menu bar.



Set the scan Targets.
Scan targets

“Adaptor Name”

Selects the name of the adaptor which is to perform scanning.
 (Name set at par. 6-5 “Adaptor Setting”)
Unit Registration is necessary for each adaptor.
When an adapter is set at a blank line, a blank line is added below it.
The same adapter can be set on multiple lines and different refrigerant system can also be 
specified.

“Secure Reg.”

Specifies by checkbox whether or not secure registration is to be performed when scanning
Checked: Secure registration (Recommended)  Not checked: No secure registration
When scanning is performed by secure registration, operation of the units is stopped.
When you do not want to stop operation, uncheck the checkbox.
See par. 11-1 No.4.

“Ref. No.”
“Start” When partially scanning, specify the start number of the refrigerant system by pull-

down menu or key input.   See par.11-1 No.8.

“End” When partially scanning, specify the end number of the refrigerant system by pull-
down menu or key input.

“Device”

“Name” Displays the name of the device used by the relevant network.

“Status” Displays the status of the device used by the relevant network.
Normal: “Ready”  Abnormal: “Error”  Not connected: “Blank”

“Check”

When the (a) “Wink” button is clicked, the SVC lamp of the Transmission adaptor 
used by the relevant network lights (for approx. 2 second) and connection of the se-
lected adaptor can be identified. (Effective only when the status of the Transmission 
adaptor is normal.)
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5

(a)

Description of screen

Click the “Start” button.
Click the “OK” button. (The following screen is displayed only when “Secure Reg” is checked.)


Starts scanning. (Disabled when there is no scanning target.)

The time required by scanning differs with the size of the system. Use the indicator displayed at (b) 
during scanning as a guideline.
While scanning is being performed, the “Stop” button (c) is displayed. To stop scanning, click this button.

All systems connected to 1 Transmission adaptor (U10 USB Network Interface) are stopped during scan-
ning for secure reg.

Note

(b)

(c)

VRF network list display during scanning

When scan ends, “Done” is displayed at the progressive bar display.
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If the following message is displayed after scanning is completed, the necessary information cannot be 
acquired.
"Information was not acquired for some units. Perform unit  registration again."
In this case, always perform scan again to acquire all the necessary information. 
If advanced to next as is, normal operation will become impossible. 
Especially, if there is a unit for which information could not be acquired when electricity charge apportion-
ment is performed, the refrigerant system including that unit will not be handled by the electricity charge 
apportionment function. 
When these information missing units are included in “Unit Newly Detected”, since they are displayed in 
red characters, treat them as the index of refrigerant system specification when rescanning.

Note

“Unit newly detected” list: ●
After the end of scanning, displays the units 
newly detected.
At initial scanning, all the units are displayed. 
After the 2nd scanning, only the units newly 
detected are displayed.
Model names for S/V series will not be dis-
played.

“Unit not detected” list: ●
When scanning was performed for the 2nd 
and subsequent times, displays the units 
which are already registered but were not 
detected this time.

5

As a result of performing scan, a unit of the same address may be displayed in the “Unit Newly Detect- ●
ed” list and “Unit not detected” list.
This occurs when a registered unit was changed to a different model and set to the same address as 
the previous unit, etc.
Since the registration information of the previous unit is erased when registration is completed, con-
tinue at that setting.
When intentionally removing a unit from registration, etc, because the unit is removed from the electric  ●
power charge apportionment objective or other reason, confirm it here. (Perform scanning after turning 
off the power of the unit removed from registration.)
Depending on the R.C. connected to the indoor unit, "R.C. address" part of the "Address No." column  ●
may show different value from that being set to the indoor unit. 
The same applies to the "Address No." and "Address" column of other screens. 
The numbers in the "Address No." corresponds to "Refrigerant system address" - "Unit address" - 
"R.C. address".

Note

“OK” button:  Saves the detected unit configuration detected by scanning.5
“Cancel” button:  Ends scanning without saving the scanned result.
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“Description Property Setting”6-7 
Values of description properties of all objects within the selected unit can be modified at once.

Select the menu items in order of “Setting”→“Description Property Setting” from the Menu bar.



Up to 50 characters can be entered.


Click the “OK” button.
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“6-8 Change Password”
Change the password.

Select the menu items in order of "Setting"→"Change Password " from the Menu bar.



Enter the current password.
Enter the new password.
(Within 20 characters of alphabet, numeric, and symbol)

Enter the new password again for confirmation.

5

When “Omit Login screen at startup” is checked, the password screen is omitted at application starting 
from the next time.
At the end of an application, at DB importing,  etc. the password input screen is displayed the same as 
up to now.

"OK" button: 5  Saves the new password.
"Cancel" button: Ends without saving the revised contents.
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Electricity Charge Apportionment (ECA) Setting7. 
Performs basic settings related to electricity charge apportionment necessary before operation. You may 
also update the settings due to facility and tenant changes.
At initial starting after installation, perform setting in accordance with the following flow. For settings and 
changes after operation starts, perform the necessary settings in accordance with the contents of par. 7-2 
and subsequent paragraphs.

Basic Setting Flow7-1 
Perform initial setting in accordance with this flow.

7-2 Understand electricity charge apportionment and confirming caution items.

7-3 “Model name setting”
 Set all the places where Model Name of the main screen is displayed in red.

• Use ReadProperty Service or ReadPropertyMultiple Service from B-OWS to read the value of 
Present_Value property of the MI 0200000(ECA Status) object and confirm that it is “2”.

• Use WriteProperty Service to write the command value at the Present _Value property of the 
MO 0100000 object from B-OWS.

1:When ending electricity charge apportionment data collection
2:When starting electricity charge apportionment data collecting by calculation including in-

door units
3:When stating electricity charge apportionment data collection by calculation not including 

indoor units
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Overview7-2 

Purpose of electricity charge apportionment1. 
The electricity charge apportionment function apportions air conditioner electricity charges to tenants. 
Generally, indoor units are divided among and used by each tenant, and calculation of the electricity 
charge for each tenant is easy. But since outdoor units are shared by multiple tenants, calculation of 
the electricity charge for each tenant is not easy. 
The electricity charge apportionment function allows distribution of the electricity charges of outdoor 
units, which are a large part of the air conditioner power consumption, according to the air conditioner 
usage of each tenant.

Features of electricity charge apportionment of BACnet2. ® Gateway
Power meter is not used and electricity apportionment calculation is performed from the electricity (1) 
charges billed from the electric power company.
Apportionment calculation is performed according to indoor unit usage.(2) 
In addition to electricity charge calculation of outdoor units only, electricity charge calculation (3) 
including indoor units is also possible.
In case of heat recovery system(VR-II series), power consumption of RB units may be also be (4) 
included in the calculation.

Precautions for Using Electricity Charge Apportionment Function3. 
The electricity charge apportionment function requires correct setting and use in accordance with (1) 
the descriptions in this manual and Interface Specification Manual. 
If correct operation based on correct setting is not performed, a reasonable result may not be 
obtained.
The electricity charge apportionment function does not calculate official electricity charges like (2) 
those established by the laws and regulations of each country.
Gaining an understanding of the descriptions, etc. in this manual and using the electricity charge (3) 
apportionment function accordingly should be performed by the responsibility of the user.
The electricity charges used in electricity charge apportionment calculation should only be that of (4) 
the power consumed by the air conditioner.
For the electricity charge apportionment function to function properly, BACnet(5) ® Gateway must op-
erate continuously. If BACnet® Gateway is shut down or stopped by a power failure, etc. while the 
data needed by calculation is being acquired, correct electricity charge apportionment calculation 
may be not be possible.
Electricity charge apportionment is performed for units identified by scanning. When the unit con-(6) 
figuration is changed, perform scanning to re-identify the target units.
Constantly maintain the units which are the target of electricity charge apportionment calculation (7) 
in the normal operating state. 
If it is turned off for a long time, etc., data acquisition and correct calculation may not be possible.
The electricity charge for units or refrigerant systems which are the target of electricity charge ap-(8) 
portionment calculation are calculated even when it is turned off. To remove them from electricity 
charge apportionment calculation, turn off the power of the unit or refrigerant system which is to 
be removed and re-scan to remove the unit from the calculation target. 
Electricity charge apportionment calculation identifies units by address. When the address of a (9) 
unit was changed by automatic addressing function, etc., perform scanning to re-identify the cor-
rect address. 
Even when an indoor unit operation time is zero, the rate (proportion) of the electricity charge ap-(10) 
portionment is not zero because of the power consumed in the outdoor unit in standby. 
The apportionment calculation for the electricity charge cannot be performed for air conditioners (11) 
other than VRF, such as single split type, that are connected to the VRF System via convertors. 
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The S/V series and V-II/J-II/VR-II series adopt different refrigerant system control and the electric-(12) 
ity charge apportionment function adopts different method reflecting the difference. So the same 
operation condition for units may not yield the same result for S/V and V-II/J-II/VR-II series. 
The electricity charge apportionment function of VRF system can only be performed from 1 con-(13) 
troller or 1 gateway simultaneously.

BACnet® Gateway

VRF System0

Outside the calcu-
lation objective

Outside the calcu-
lation objective

Outside the calcu-
lation objective

Apportionable range

Electricity charge calculation units

Network Convertor 
(UTY-VGGX)

Network Convertor 
(UTR-VGGXZ1)

Network Convertor 
(UTR-YRDA)

RB Unit

VRF System1

VRF System2

VGGX

VGGXZ1

YRDA

RB

V-II/J-II/VR-II VRF System

S/V-VRF System

S/V

V-II/J-II 

VR-II RB RB RB

V-II/J-II 

Electricity charge apportionment error4. 
Errors and their main causes related to electricity charge apportionment, detected by the BACnet® 
Gateway are described.

Generation conditions(1) 
Generated when a unit that does not send the information necessary for electricity charge appor-
tionment (non-communicating unit) is detected during the period electricity charge apportionment 
data collection is performed.
Judgment, performed for the outdoor unit and the indoor unit, is based on whether there is no 
communication for more than 30 minutes or not.



45
Copyright© 2010-2012 Fujitsu General Limited. All rights reserved.

Se
tti

ng
s

Processing of errors by BACnet(2) ® Gateway
Electricity charge apportionment error with the unit address are displayed for the non-communi- ●
cating unit.
The generation time and recovery time are recorded in the error history as with the other errors.
In the electricity charge apportionment calculation, non-communicating unit is handled the  ●
same as an indoor unit whose operation is stopped by a remote controller.

Recovery conditions(3) 
When the data necessary for electricity charge apportionment can be acquired from the relevant 
unit, the electricity charge apportionment error is reset.
Main error generation causes(4) 

Electricity charge apportionment errors are mainly generated when the power breaker of a unit  ●
is switched off.
(Because apportionment data is not sent when the power breaker is switched off.) 
When the power breaker of only part of the units in a refrigerant system is switched off, outdoor 
unit trouble may occur.
Therefore, if there is a unit whose power breaker is switched off, quickly recover the power by 
switching on the breaker.
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“Model Name Setting”7-3 
Model Name is automatically acquired at scanning.
When the data was collected normally, Model Name is Displayed at “Acquired Name” and “ECA Name”.
When the data could not be collected normally, Model name is displayed in red. In this case, set Model 
Name individually.

S/V Series cannot obtain Model Name even by scanning. (This function cannot be used.)* 

Select the menu items in order of “Setting”→“Model Name Setting” from the Menu bar.


Select “Model Name”.

 

For the outdoor unit or indoor unit  
without any RB unit connected. For the indoor unit with RB unit connected

Click the “OK” button.



8. Operation

Operation
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Operation8. 

Starting and Ending the BACnet8-1 ® Gateway
Starting the BACnet��

® Gateway
Make sure that USB Adaptor Connections (Refer to 5-2 Hardware Installation.) are completed and the 
Ethernet cable for the BACnet® Gateway is connected to LAN port of the PC before starting up the appli-
cation.

Select "BACnet ® Gateway for VRF System" from the Windows start menu.



Enter the Login ID.
Enter the Password.







Click the “OK” button.
When “BACnet5 ® Gateway for VRF System” boots up, 
the main screen is displayed. (Refer to 8-2 Main Screen.)
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Ending the BACnet��
® Gateway

Select the menu items in order of “File”→“Exit” from the Menu bar



Enter the Login ID.
Enter the Password.







Click the “OK” button.

5

Click the “OK” button.5
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Main Screen8-2 

Menu bar

Tool bar

Status bar (When an error occurs, the error message “In Error” is displayed.)

A

B C D E F

This software has the following functions 

Menu bar (Command name) Contents Tool bar

1 “File”
“Import / Export”

“Unit List(EDE)  
Export”

Exports “Unit List(EDE)” data to a CSV format 
file. -

“All Data Import” Imports the data backed up by “All Data Ex-
port”. -

“All Data Export” Backs up the internal data. -
“Exit” - The BACnet® Gateway ends. -

2 “View”

“VRF System”

“All  
(All adaptors)”

Displays the Status information of all the 
indoor units or outdoor units connected to this 
system.

E

“Adaptor*”

Displays the Status information of the indoor 
unit or outdoor unit of the selected adaptor.
* A maximum of 4 adaptors can be connected. 
Menus for only the number of connected 
adaptors are displayed

E

“Unit”

“Indoor Unit”
Displays the Status information of the Indoor 
Unit connected to the adaptor selected by [VRF 
System] menu.

F

“Outdoor Unit”
Displays the Status information of the Outdoor 
Unit connected to the adaptor selected by [VRF 
System] menu.

F
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Menu bar (Command name) Contents Tool bar

3 “Control”

“Operation Setting” -

The following setting screen of indoor unit is 
displayed.
Operation “on/off”
“Operation mode” switching
“Set temperature” switching
“Fan speed” switching

(Outdoor Unit cannot be set.)

D

“Device Communication 
Disable” (*1) -

Device communications is disabled.
* When this setting is performed, communica-
tion with the VRF System is not stopped.

A

“Device Communication 
Disable_Initiation” (*1) -

The initiation of communications is disabled.
*When this setting is performed, communica-
tion with the VRF System is not  stopped.

B

“Device Communication 
Enable” (*1) - Communications is enabled. C

“Out of Service” “False” Set Out_Of_Service properties of all BACnet® 
objects to "False". -

4 “Error”
“Error Notification” - Displays the current error information. -
“Error History” - Displays the error information history. -

5 “Setting”

“Initial Setting” -

Set when installing equipment.
Refer to par. 6. Basic Settings.

-
“Change Password” - -
“Adaptor Setting” - -
“Unit Registration” - -
“Model Name Setting” - -
“Description Property  
Setting” - -

6 “Help”

“Manual” - Instruction manual (this manual) is displayed. -
“Interface Specification 
Document” - Interface Specification Document is displayed. -

“Version Information” - Version information is displayed. -
About Device Communication Control Service  *1. 
The 3 functions “Device Communication Disable”, “Device Communication Disable_Initiation” and “Device Com-
munication Enable” can be set for a Device itself. (Time Duration, Password cannot be set) This setting can be 
set from a BACnet® Device (B-OWS, etc.) This value can be overwritten from B-OWS.

VRF System0

VRF System1
PC

(BACnet® Gateway)
BACnet® Device
(B-OWS, etc.)

VRF System2

VRF System3
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“Data Import/Export”8-3 

“Unit List (EDE) Export”85555 

Description of function1. 
Export “Unit List(EDE)” data to a CSV format file.

About “EDE”
The contents of “EDE “ sheet and “State-Texts” sheet of The Engineering Data Exchanger (EDE) 
template created by BACnet® Interest Group Europe is output in CSV format. In addition, the “set-
table” field of the “EDE” sheet is not used.

Operating procedure2. 
Select the menu items in order of “File”→“Import/Export”→“Unit List (EDE) Export” from the Menu bar.



Specify the Export destination folder and click “OK”. 
The folder to be saved shall be created in advance.


When “OK” is clicked, the export is complete.
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“All Data Import”85555 

Description of function1. 
Import the data backed up by “All Data Export”.

Operating procedure2. 
Select the menu items in order of “File”→“Import/Export”→“All Data Import” from the Menu bar.



Enter the Login ID.
Enter the Password.







Click the “OK” button.
Specify the file to be imported and click “Open”.5

5
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When “OK” is clicked, the import starts.



When “OK” is clicked, the import is complete. 
After the main screen is closed, restart BACnet ® Gateway.

“All Data Export”85555 

Description of function1. 
Back up the “All Data” (internal data).
All Data : Connected U10 USB Network Interface adaptor data, scanned unit data, and data set by B-

OWS.

Operating procedure2. 
Select the menu items in order of “File”→“Import/Export”→“All Data Export” from the Menu bar.



Specify the export destination folder and click “OK”. 
The folder to be saved shall be created in advance.


When “OK” is clicked, the export is complete.





55
Copyright© 2010-2012 Fujitsu General Limited. All rights reserved.

O
pe

ra
tio

n

“View”8-4 

Description of function1. 
The Indoor unit and Outdoor unit Status information can be viewed.

Operating procedure2. 
Select the VRF System (“All” or “Adaptor*”) that you wish to display.
Menus for only the number of connected adaptors are displayed* 
Select the menu items in order of “View”→“VRF System”→“All” or “Adaptor*” from the Menu bar



Select the displayed unit (indoor unit or outdoor unit).
Select the menu items in order of “View”→“Unit”→“Indoor Unit” or “Outdoor Unit” from the Menu bar



Example) When set to “All” and “Indoor unit”

Items displayed in the Status List.3. 
I.U.=Indoor unit    O.U.=Outdoor unit

Items Remarks I.U. O.U.
“R.C.Group Name” Remote controller group name  -
“Unit Group Name” Outdoor group name - 

“System Type” Displays the type of refrigerant system  
(cooling only , heat pump or heat recovery)  

“Adaptor Name” Connected U10 USB Network Interface adaptor name.  
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Items Remarks I.U. O.U.

“Address”

Displays the address for each unit. “Refrigerant system 
address”-“Unit address”-“R.C. address” or “Refrigerant system 
address”-“Unit address”-“R.C. address”-“RBG No”
For V-II/J-II/VR-II series following notations apply for the ad-
dress suffix to show how the units are controlled in AUTO 
mode;

/M Master indoor unit
/S Slave controlled by master indoor unit
/O Externally controlled

Those without suffixes are units that not any of the aboves.

 

“Indoor Unit Model Name” Unit model name  -
“Acquired Name” Model name. acquired from unit  -
“ECA Name” Model names used with electricity charge apportionment  -

“RB Model Name” RB model name - 

“Acquired Name” Model name. acquired from unit
Only when RB unit is connected. - 

“ECA Name” Model names used with electricity charge apportionment - 
“Outdoor Unit Model Name” Unit model name  -

“Acquired Name” Model name. acquired from unit  -
“ECA Name” Model names used with electricity charge apportionment  -

“Description” Explanation for Indoor/Outdoor units  
“Capacity” Capacity of Indoor units 

“TYPE” Indoor unit type
*Universal shows Floor or Ceiling.  -

“Operation Status” Operation Status  -
“OP” Operation status.  -

“MODE” Displays the operation mode. 
(Displayed even when stopped.)  -

“Set Temp.” Displays the set temperature.  -
“Fan Speed” Fan speed displays the air flow setting.  -

“Reliability” Shows any of the values other than "No_Fault_Detected",of the 
reliability properties of the objects contained in the unit.  

“Out of service” Shows "True" if any one of the values of the Out_Of_Service 
properties of the objects contained in the unit is "True".  

“Error” State separate from original instruction and operation  
“Code” Error code of current error  
“Contents” Error code details  
“Time of Occur-
rence” Time error occurred  

“Total Count of  
Occurrences” Number of errors which occurred from start up to the present  

“Emergency Stop” Displayed when emergency stop signal sent/received  

“Priority Operation Mode” Cooling/heating priority operation  
(Heat pump of S/V Series only) - 
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“Control”8-5 

“Operation Setting”85555 

Description of function1. 
Indoor unit “On/Off”, “Operation Mode”, “temperature setting”, and “Fan speed” can be set.

Operating procedure2. 
Select indoor unit.
Select the menu items in order of “View”→“Unit”→“Indoor Unit” from the Menu bar


Click the unit (line) that you wish to select.



Select the menu items in order of “Control”→“Operation Setting” from the Menu bar
or

Click the D  button.



D
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“Operation Setting” screen is displayed.
When the set button is pressed, “On/Off”, “Operation Mode”, “Set Temp. ”, and ”Fan Speed” can be 
set.
Function which cannot be set is not pressed.* 

“Reset” button: When this button is 
pressed, returns to the setting state 
when this screen was displayed.



5

Function List

“On / Off” Switches operation of the selected Indoor Unit On/Off.
“Operation Mode” Switches Operation Mode to “Auto”, “Cool”, “Dry”, “Fan” or “Heat”.
“Set Temp” Changes the set temperature.
“Fan Speed” Switches Fan speed to “Auto”, “Low”, “Med” or “High”.

Click the “Send” button.5
Indoor unit setting is switched. 

“Device Communication Disable”85555 

Description of function1. 
Device communications is disabled.
When this setting is performed, communication with the VRF System is not stopped.* 

VRF System0

VRF System1
PC

(BACnet® Gateway)
BACnet® Device
(B-OWS, etc.)

VRF System2

VRF System3
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Operating procedure2. 
Select the menu items in order of “Control”→“Device Communication Disable” from the Menu bar

or
Click the A  button.

A



Click the “OK” button on the window of “Disable device communications” shown below.



“Device Communication Disable_Initiation”85555 

Description of function1. 
The initiation of communications shall be disabled.
When this setting is performed, communication with the VRF System is not stopped.* 

Operating procedure2. 
Select the menu items in order of “Control”→“Device Communication Disable_Initiation” from the 
Menu bar

or
Click the B  button.



B

Click the “OK” button on the window of “Disable initiation of communications” shown below.





60
Copyright© 2010-2012 Fujitsu General Limited. All rights reserved.

O
pe

ra
tio

n

“Device Communication Enable”85555 

Description of function1. 
Communications is enabled.

Operating procedure2. 
Select the menu items in order of “Control”→“Device Communication Enable” from the Menu bar

or
Click the C  button.



C

Click the “OK” button on the window of “Enable device communications” shown below.
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“Out of Service”85555 

Description of function1. 
Set Out_Of_Service properties of all BACnet® objects to “False”.

Operating procedure2. 
Select the menu items in order of “Control”→“Out of Service”→“False” from the Menu bar


Click the “OK” button on the window of “All objects will be put in service.” shown below.
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“Error”8-6 
“Error information” and “Error History”can be viewed.

Displays “Error Information”85855 

Select the menu items in order of “Error”→“Error Notification” from the Menu bar
or

Automatically opens at error generation.



“Error Notification” screen is displayed.

 

“Error Notification” screen
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Items displayed in the ERROR List of Indoor/Outdoor Unit.

Items Remarks
“Date” Date error occurred

“Unit Group”
When "Indoor Unit” is selected, “R.C.Group Name” is displayed.
When "Outdoor Unit" is selected, “Unit Group Name” is displayed.
Otherwise, ""-"" is displayed.

“Model Name”

Unit model name*
*The letter ":" as the last letter of the Model Name signifies that the Model Name for the 
corresponding unit was written after shipment. 
The letter ":" is not part of the Model Name.

“Adaptor Name” Connected U10 USB Network Interface adaptor name.

“Address” Displays the address for each unit. Display contents: "Refrigerant system address 
"-"Unit address"-"R.C address".

“Error Code” Error code
“Contents” Contents

Displays “Error History”85855 

Select the menu items in order of “Error”→“Error History” from the Menu bar
or

Click the “History” button of the “Error Notification” screen.

“Error History” screen is displayed. 

“Help”8-7 
“Instruction manual”, “Interface Specification Document”, and Version information of BACnet® Gateway is 
displayed.

Displays “Manual”85855 

Select the menu items in order of “Help”→“Manual” from the Menu bar



“Instruction manual” (this manual) is displayed.
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Displays “Interface Specification Document”85855 

Select the menu items in order of “Help”→“Interface Specification Document” from the Menu bar
“Interface Specification Document” is displayed. 

Displays Application “Version Information”85855 

Select the menu items in order of “Help”→“Version Information” from the Menu bar
“Version Information” is displayed.



9. Product Specifications
10. Error Code Table
11. FAQ

Appendix
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Product	Specifications9. 
Operating Conditions9-1 

PERSONAL COMPUTER SPECIFICATIONS

Operating system

•Microsoft® Windows® XP SP3 (32-bit) Professional
•Microsoft® Windows® Vista® SP2 (32-bit) Home Premium, Business
•Microsoft® Windows® 7 SP1 (32/64-bit) Home Premium, Professional
[Supported languages]
English, Chinese, French, German, Russian, Spanish, and Polish

CPU Intel® CoreTM i3 2GHz or higher

Memory 2GB or more (Windows® XP, Vista®, 7 32-bit)
4GB or more (Windows® 7 64-bit)

HDD 40GB or more of free space

Display 1024 x 768 or higher resolution

Interface USB port (x2-5) is required
Ethernet port is required

Software required Adobe® Reader® 9.0 or later

Hardware required DVD-ROM Drive

Accessories9-2 
DVD-ROM (Application and Manual) ................................................................................... (1)
USB Software Protection key .............................................................................................. (1)
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Error Code Table10. 
The BACnet® Gateway error codes are shown below. When an error occurred at the BACnet® Gateway, 
check the codes below and contact your service personnel.
Refer to the Interface Specification document for the Indoor unit and Outdoor unit error codes.

Error code Error contents

F11 Database access error

F12 Database connection error

F13 Software restart error

F14 Program run time error

F15 Error at execution of various special operations

F16 Insufficient vacant space on HDD used by database

F21 Transmission adaptor connection failed

F22 Transmission error (data not acquired)

F23 External input power meter error

F31 Communication between processes error

F32 Software protection key not recognized (including fault WIBU-KEY obstruction)

F33 Server/client communication error

F41 HDD capacity error

F42 System requirements error

F43 Time error
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FAQ11. 
General11111

No.
Question

Answer

1.

The PC power was dropped during unit scanning. What happens to the data scanned up to the point?  
Is data integrity maintained?

The scanned data is saved when scanning is completed and the “OK” button is pressed.
When the power was dropped before this, the data scanned up to that point is lost. Restart scanning from 
the beginning.   → 6-6 “Unit Registration”.

2.

When scanning, U10 USB Network Interface is not displayed as a selection choice. What should I do?

U10 USB Network Interface driver is not installed.
Install the OpenLDV supplied with the U10.
Power is not supplied.
If an USB hub is used or many USB units are connected, the power supply may be insufficient. Connect 
the USB units directly to the PC, or reduce the number of USB units connected.

3.

Can the U10 USB Network Interface used with the BACnet® Gateway also be used with service tools and 
other software?

The adaptor can also be used with service tools. However, 1 adaptor cannot be used simultaneously by 
the BACnet® Gateway and service tools.

4.

What is the difference between Secure Reg enable and disable at “Unit Registration”?

Secure Reg. is a mode which stops operation of all the units and confirms scanning for “Unit Registration”. 
Secure Reg. disable is a mode which performs scanning in parallel without stopping operation of the units.
Since scanning is an important function for recognition of the units to be managed by the BACnet® Gate-
way, it is recommended that, as a rule, it be performed by enabling Secure Reg. If unavoidable, disable 
Secure Reg only when scanning must be performed without stopping operation of the units. In any case, 
whether or not units were recognized correctly must be confirmed after scanning. However, when scan-
ning was performed with Secure Reg disabled, re-scanning may be necessary due to “Unit Registration” 
failures.

5.

Scanning was performed, but all the units were not recognized. What should I do?

When work is performed normally and scanning is performed after confirmation and units are not recog-
nized, first check that the power of the unrecognized units is turned on.
Other causes may be:
 •Unit trouble
 •Installation work problem
 Contact your service personnel.

6.

Scanning was performed, and all the units were recognized, but R.C. group information is not correct. 
What should I do?

They may be an abnormality in the wiring which defines the R.C. group or incorrect setting of the address 
in the indoor unit R.C. group. Refer to the service manual and perform setting correctly.

7.

Scanning was performed and all the units were recognized, but the unit information is not correct. 
What should I do?

It is possible that communication with the unit is incomplete. 
Enter a secure reg. check mark and re-scan. → 6-6 “Unit Registration”.

8.

Scanning takes a very long time. What can I do?

When the existing refrigerant system numbers are known in advance, the scanning time may be short-
ened by specifying the refrigerant range to be scanned at the scan execution screen. For example, when 
rescanning, etc. when recognition by scanning isn’t very good, the scanning time can be shortened by 
specifying the range of only the refrigerant systems at which recognition was poor. In addition, scanning 
by “secure reg.” is faster than scanning “without secure reg.”. → 6-6 “Unit Registration”.
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No.
Question

Answer

9.
I want to replace the PC with a new PC. Can the data be transferred?

The BACnet® Gateway has data “Export” and “Import” functions.
For details, see the “Import/Export” page.

10.
Unit expansion, replacement, and removal were performed. How can I reflect these changes at the 
BACnet® Gateway?

Perform scanning again. → 6-6 “Unit Registration”.

11.
VRF System expansion, replacement, and removal were performed.

After setting the U10 USB Network Interface adaptor correctly, recognize the units by scanning.
→ 6-4 “Initial Setting” , 6-5 “Adaptor Setting”, 6-6 “Unit Registration”

12.
The state displayed on the screen does not change even though operation setting is performed.

When operation setting was performed at multiple units or at a group containing multiple units, it may take 
some time for the state of that unit to change to the set contents.

13.
Can a transmission adaptor (UTR-YTMA) be used with the BACnet® Gateway?

Transmission adaptor (UTR-YTMA) cannot be used with the BACnet® Gateway.

14.
Can a WIBU-KEY used by a UTR-YLBA be used by the BACnet® Gateway?

Since the UTR-YLBA and BACnet® Gateway are separate products, the WIBU-KEY used by the UTR-
YLBA cannot be used by the BACnet® Gateway.

15.
 Can a XLON® used by a UTR-YLBA be used by the BACnet® Gateway?

No. it cannot be used.

16.

When an error, etc. occurs at SQL Server 2008 R2 installation while this application is installed

For the identification of reason and the countermeasures, check the contents of log file in the following 
folder.
    C:\Program Files\Microsoft SQL Server\100\Setup Bootstrap\Log  

17.

Why is an electricity charge generated even though none of the indoor units is being used?

Since power is consumed by the outdoor unit even when all the indoor units are not in use, an electricity 
charge is generated.
To prevent generation of an electricity charge, turn off the power of that indoor unit and perform scan to 
remove the indoor unit from the electricity charge apportionment function objectives.

18.

Why isn’t the operation time and electricity charge proportional?

If the room temperature has reached the set temperature even if the operation is turned ON by a remote 
controller, the indoor unit will not operate and the power consumption will be that much lower.
In addition, if the difference between the room temperature and the set temperature is large, more power 
is consumed than when the difference is small. Therefore, the operation time and electricity charge may 
not necessarily be proportional.

19.

Why is the electricity charge of operated indoor units so much smaller than that of indoor units that are not 
operated at all?

Electricity charge includes the power consumed by the outdoor unit in addition to that of the indoor unit. 
The outdoor unit consumes power constantly so that operation at any time is possible even though indoor 
units are not operating. This is called the “standby power”. Since the standby power differs between the 
models of outdoor units, if the number of indoor units per outdoor unit is assumed to be the same, the 
indoor units which use an outdoor unit will consume more power than indoor units which use with high 
standby power.
This question is an example of when the difference of this standby power was larger than the power con-
sumed by operation. This is a normal result. Generally, this kind of difference is made small by selecting 
the model of outdoor unit based on appropriate facility design.
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20.

Why has the electricity charge suddenly increased even though the use is the same as in the past?

One of the reason could be that some tenants have moved out. The electricity charge is apportioned 
between blocks. When the number of blocks decreases or increases by moving in and out of tenants, the 
electricity charge increases and decreases. As an example, if the basic charge is set so that it is equally 
apportioned between the blocks, then the electricity charges decreases if tenants move in and increases if 
tenants move out. The building owners and managers should perform appropriate settings in accordance 
with his/her policy as to how things should be in such cases.

21.

Characters displayed on the screen are strange. What should I do?

Region is not set.
Refer to 5-3 “Regional Setting” and set the region.
OS or PC trouble
Contact the manufacturer of your PC.
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Trouble Shooting BACnet11-2 ® Installation

Trouble Shooting Procedures
If you can not perform monitorings and controls of VRF system form B-OWS, the first step for the trouble
shooting is to localize the trouble.

Q3.Can the VRF system be monitored and controlled by Service Tool?

Communication OK?

Service Tool (UTY-ASGX)

Q2.Can the VRF system be monitored and controlled by BACnet® Gateway?

Q1.Can the VRF system be monitored and controlled by B-OWS?

B-OWS : Operator Workstation, workstation used in the building management system.

VRF System
BACnet® Gateway B-OWS

Answer each questions in the diagram to see what sort of troubles are suspected.

Q1.Can the VRF system be monitored and controlled by B-OWS?
If no, any of the troubles below is suspected;
S1)VRF system is faulty or is not setup properly.
S2)Communication between BACnet® Gateway and VRF system is not normal.
S3)BACnet® Gateway is faulty or is not setup properly.
S4)Communication between the B-OWS and BACnet® Gateway is not normal.
S5)B-OWS is faulty or is not setup properly.

Q2.Can the VRF system be monitored and controlled by BACnet® Gateway?
If no, any of the troubles below is suspected;
S1)VRF system is faulty or is not setup properly.
S2)Communication between BACnet® Gateway and VRF system is not normal.
S3)BACnet® Gateway is faulty or is not setup properly.

Q3.Can the VRF system be monitored and controlled by Service Tool?
If no, the trouble below is suspected;
S1)VRF system is faulty or is not setup properly.

For each of the troubles suspected, perform the following checks to identify the problem.

S1.VRF system is faulty or is not setup properly.
If the VRF system itself is not working properly, consult the the Service Manuals for VRF system.

S2.Communication between BACnet® Gateway and VRF system is not normal.
If the communication within the VRF system is not working properly, consult the Service Manuals for
VRF system.
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S3.BACnet® Gateway is faulty or is not setup properly.
Refer to the Instruction Manual (this manual) of BACnet® Gateway.
See also A1.Initial setting for PC.

S4.Communication between the B-OWS and BACnet® Gateway is not normal.
See A2.Networking Troubles.

S5.B-OWS is faulty or is not setup properly.
Refer to the manual that comes with the B-OWS.
Be sure that settings are correct for connecting with the BACnet® Gateway.

A1:Initial Setting for PC
Network Setting for the PC(1) 
Perform appropriate setting for the transparent connection of UDP/IP unicast and multicast communi-
cation.

IP Address / Netmask Setting ●
UDP port 0xBAC0(47808) made available and enabled ●
When checking whether the UDP port is already in use, execute a “netstat  -a” command from the 
Windows Command Prompt. At that time, end BACnet® Gateway before executing the command.
If the UDP port should be in use, stop using the relevant application.

A2:Networking Troubles
Checking Unicast Communication(1) 
Ping to/from BACnet® Gateway – B-OWS using Windows Command Prompt.
Ex. “Ping 192.168.16.2”
If you get the response, unicast is reachable.
Checking Broadcast Communication(2) 
Trace route to/from BACnet® Gateway – B-OWS using Windows Command Prompt.
Ex. “Tracert 192.168.16.2”

Trouble Shooting the Interworking Troubles
BACnet® is an open network protocol interpreted and implemented by different vendors.
In some occasions, you may encounter interworking troubles.
If the trouble could not be located in the procedures above, interworking troubles may be suspected.

Analyzing interworking troubles involve capturing BACnet® communication packets and analyzing the
protocol using tools (ex.Wireshark) and expertise on BACnet®.

Followings are some hints on the checks you need to perform in order to trouble shoot interworking prob-
lems.

Has B-OWS recognized BACnet1. ® Gateway?
If the B-OWS does not recognize BACnet® Gateway, then the initial setting may be wrong or network-
ing problem is suspected.

Has B-OWS established connection to the BACnet2. ® Gateway?
If the B-OWS cannot establish connection with BACnet® Gateway (eg.B-OWS has issued error after 
series of communication), then packets must be captured to see where and what has gone wrong.

Has B-OWS registered units in VRF System correctly?3. 
If the B-OWS cannot register units in VRF System correctly, then registration must be checked first us-
ing BACnet® Gateway user interface. If there are no problems on the BACnet® Gateway, then packets 
must be captured to see where and what has gone wrong.

What Service is Malfunctioning?4. 
If any service cannot be performed on the B-OWS, then packets must be captured to see where and 
what has gone wrong.
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